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Absfract- Group collaboration capabilities have been developed 
for Internet-based Mars rover mission operations. Internet-based op- 
erations enables scientists to participate in daily Mars rover mission 
operations from their home institutions. Group collaboration enables 
geographically separated users to collaboratively analyze downlinked 
data and plan new activities for the rover. The motivation for group 
collaboration in Mars rover mission operations and the technologies 
developed to provide group collaboration are discussed. The gronp 
collaboration capability was developed for use in rover mission oper- 
ations in the 2003 NASA Man Exploration Rover mission. 
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I. INTRODUCTION 
ASKS Mars Exploration Rover (MER) mission will N land two rovers at different locations on'Mars early 

in 2004. The rovers will be equipped with various science 
instruments to perform scientific analysis of the Martian 
terrain. Instruments will be on a mast as well as on a five 
degree of freedom manipulator arm. During each rover's 
three month primary mission, they will traverse a total of 
about 1 Km while exploring various locations in detail. 

Command sequences will be sent to the rovers from 
Earth once a day and the rovers will send downlink data to 
Earth once a day. The mission operations system that will 
be used to generate the daily command sequences will be 
primarily located at JPL. In addition, an Intemet-based sci- 
ence operations system will enable some scientists to par- 
ticipate in daily science activity plan generation from their 
home institutions. 

Intemet-based operations reduces mission costs by en- 
abling scientists to remain at their home institutions while 
participating in the mission. Transportation, housing, and 
facilities costs are all reduced by enabling remote partic- 
ipation. Also, distributed operations enables participation 
by some scientists who would not be able to move to the 
JPL area during the mission. 

There are various challenges to utilizing Intemet-based 
operations for Mars rover missions. An architecture must 
be provided that enables numerous clients to participate si- 
multaneously from various remote locations. Data needs to 
be quickly transmitted each day to the participating scien- 
tists. Group collaboration capabilities are needed to enable 
the various participants to work together efficiently while 
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being geographically separated. 
The Web Interface for Telescience (WITS) was devel- 

oped to provide Internet-based distributed operations for 
Mars lander and rover missions. WITS was originally 
used as the ground operations system for the Rocky7 re- 
search rover for sequence generation [l]. An adaptation of 
WITS was used for Robotic Arm and Robotic Arm Camera 
command sequence generation for the-Mars Polar Lander 
(MPL) mission which was to begin surface operations in 
December 1999 [2]. Unfortunately, communication with 
the MF'L lander on the Martian surface was not achieved, 
so commanding the lander was not possible. 

WITS is currently used for visualization and command 
sequence generation for the Field htegrated Design and 
Operations (FIDO) rover. The FIDO rover is a prototype 
rover equipped with instrumentation designed to simulate 
the Athena Payload for the MER mission [3], [4]. Stereo 
cameras on the rover's mast and body are used to image 
the surrounding terrain. An instrument arm places a micro- 
scopic imager on selected surface targets. An infrared point 
spectrometer on the mast is used to characterize the terrain. 
The group collaboration capability described in this paper 
was integrated into WITS and demonstrated for FIDO rover 
operations. 'Examples used in this paper are from FIDO 
rover operations. 

An adaptation of WITS will be used for science planning 
for the MER mission. Scientists at the primary JPL oper- 
ations center will collaborate with Internet-based scientists 
to generate the daily science activity plan. 

Before the development of the group collaboration tech- 
nologies described in this paper, WITS provided distributed 
but not collaborative participation by geographically dis- 
tributed users. Downlink data was sent to remote users 
who could view the data, select targets, and submit sub- 
sequences to the common server. When users wanted to 
discuss data with colleagues, it was quite difficult to com- 
municate to other remote users which images to view, and 
what features in the images were of interest. With increas- 
ing numbers of distributed users, it became very confusing 
when trying to communicate. Also, when a new user joined 
in middle of a planning session, it was difficult to get that 
person oriented to the current planning state. 

From that distributed operations experience, the group 
collaboration features that were needed to make distributed 
collaboration efficient were identified. It was necessary to 
know what images and data products other users were look- 
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Fig. 1. FIDO Distributed Operations Architecture 

ing at. It was necessary to easily be able to point out a spe- 
cific terrain location in an image and have all other users 
see that location immediately annotated. It was needed to 
be able to get the attention of another user after a period 
of inactivity by the group. It was needed to have separate 
groups of people working together on specific topics. It 
was needed to be able to send messages to other users. The 
identified necessary group collaboration features were de- 
signed, developed, and integrated into WITS. 

11. DISTRIBUTED ROVER OPERATIONS 

The distributed operations architecture for FIDO rover 
field test operations is shown in Figure 1. There is one 
WITS server and many WITS clients which communicate 
via the server. 

The process for generation of one uplink sequence be- 
gins with the downlink of data from the rover. This data is 
automatically processed and placed in the primary database 
using the Parallel Telemetry Processor (PTeP) [SI. The 
Multi-mission Encrypted Communication System (MECS) 
system distributes the new data products to the remote 
users. MECS was developed to provide data distribution 
with the necessary Intemet security [6],  [7]. 

Once users have the updated downlink data, they can 
view the data using the visualization views of WITS. Dis- 
tributed users have the same visualization and sequence 
editing capabilities as users at the primary operations cen- 
ter. A screendump of various windows and views of WITS 
is shown in Figure 2. The Panorama view is a mosaic 
of images taken by the stereo cameras on the rover mast. 
The Overhead view shows the area around the rover from 
above. Various image types are provided with the Over- 
head view including color-coded elevation maps (shown in 
the figure) and texture maps. The 3D view shows the 3D 
rover and terrain. A Wedge view shows one image from a 
stereo camera in full size and resolution. Users can view 
the downlink data by themselves or collaboratively. 

After viewing the downlink data, the users decide what 
the rover should do in the next sequence. They might do 
this by themselves initially, but then they join a collabo- 
rative planning meeting where 3D science targets are se- 

lected and the sequence is developed. The group features 
described below are used in the collaborative sequence de- 
velopment. 

Science targets are 3D terrain locations that can be used 
as parameters in commands. They are shown in the views 
as pink circles with the name of the targets next to them. 
Any participating user can create a science target. An ex- 
ample use for a science target is as a location to point the 
mast-mounted spectrometer at. Target IPS-1 is used for this 
purpose in the example sequence. Rover waypoints are 3D 
terrain locations that the rover will traverse to. Waypoints 
are shown in the views as blue squares. Targets and way- 
points entered by distributed users can be loaded, viewed, 
and used by all users. 

The Sequence window is used to edit a command se- 
quence. The Sequence window is a tabbed pane the 
WITS Main window as shown in Figure 2. Available com- 
mands are shown in the left column and can be inserted into 
the sequence on the right. Various editing, simulation, and 
sequence verification features are provided. Users can cre- 
ate a new sequence and submit it to the server, edit an exist- 
ing sequence, or collaboratively edit one sequence. Activi- 
ties are visualized in the views when possible. In Figure 2, 
outlines of images in a panorama command on the cliff are 
shown and nine spots around the IPS-1 target are shown for 
the IPS scan activity. 

The Resources window, shown in Figure 3, shows the 
resources that the rover would use if the sequence was ex- 
ecuted. The’ activities are shown along the bottom and the 
resource plots above them. Users edit the sequence to en- 
sure that thel resources are within allocations. 

111. GROUPS 

Group collaboration capabilities were added to make 
collaboration with distant colleagues more efficient. Group 
collaboration features are provided to the user via the 
Group tabbed pane of the WITS Main window, as shown 
in Figure 4. A user can work independently viewing data 
products and editing sequences. When the user wants to 
work with other users to collaborate in viewing data prod- 
ucts then the user joins a group. 

There are two types of groups: permanent groups and 
temporary groups. Permanent groups are provided that 
have defined purposes and cannot be deleted. For example, 
in Figure 4 the sowg group represents the permanent Sci- 
ence Operations Working Group which includes all mission 
scientists. Temporary groups can be created and deleted by 
users. , 

The Group window .“Group” menu is used for creating 
new groups, deleting groups, joining a group, and leaving 
a group. A group is created by selecting the “New” menu 
item. The user gives the group a name and then the new 
group is available to all users to join. A group is deleted 
by selecting the “Delete” menu item, and then selecting the 
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Fig. 3. Resources Window 

group name. A group cannot be deleted if it is a permanent 
group or if there are any current users in the group. 

A user joins a group by selecting “Join” in the Group 
window “Group” menu and then selecting the available 
group name. A user leaves the group they are currently 
in by selecting the “Leave” menu item. 

All users who are currently using WITS are listed in the 
left column of the Group window, as shown in Figure 4. 
The group that a user is in is shown in square brackets to 
the right of the user name, if the user has joined a group. 

IV. GROUP VIEWS 
To ensure that all group members are viewing the same 

information, the group view feature was implemented. A 
view is turned into a group view by selecting the “Add To 
Group” item in the File menu of the Panorama, Overhead, 
Wedge, and 3D views. When a view becomes a group view, 
it is opened in all group members’ clients and the word 
Group is added to its title. 

The “View” menu of the Group window provides menu 
items for management of the group views. The “Refresh 
Group Views” menu item opens all views of the user’s 
current group that are not opened, for example if the user 
closed one or more group views for some reason but now 
wants to make sure all group views are open. The “Close 
Non-Group Views” menu item closes all views except 
those in the current group. The “Close Other-Group Views” 
menu item closes all group views that are not in the current 
group. This is useful for when a user changes groups and 

wants to close the views from the previous group. By de- 
sign, the views of the previous group are not automatically 
closed when a user leaves a group or joins a new group. 
In the above menu items, Close means to close the group 
view, but leave it as an item in the group state on the server. 
The “Delete All Group Views” menu item deletes all views 
of the current group from all group members’ clients. This 
is only done by the group administrator. Delete means that 
the view is deleted from the group state on the server as 
well as closed as a view on the clients. 

V. GROUP MARKERS 

The Group window “Marker” menu is used to manage 
group markers. A marker is a 3D location selected by a 
group user and displayed on all other group users’ client 
views. Examples are shown in Figure 2. To create a marker, 
a user first selects a pixel in an image in a Panorama or 
Wedge view. The 3D coordinates are then displayed. This 
location is converted to a marker by selecting “Add“ in the 
“Marker” menu. A green triangle is drawn at the location 
in all Panorama, Wedge, and Overhead views of all group 
members and the name of the user who created the target is 
displayed next to the marker. 

The “Delete” menu item of the “Marker” menu deletes 
the user’s marker in all group member clients’ views. The 
“Delete All” menu item deletes all markers from all users 
in all group member clients’ views. The “Show” checkbox 
menu item allows the user to turn on and off display of 
group markers. 

VI. GROUP MESSAGES 

Group messages are used for textual communication be- 
tween group members. It is assumed that during collabo- 
ration, telephone-based teleconferencing or Intemet tele- 
phony are used for verbal communication. All received 
group messages are displayed in the Messages area of the 
Group window. To send a group message, a user types the 
message in the “Inputs” area of the Group window and then 
selects the “Send” button. Who the message is sent to and 
how it is sent are controlled by the selection in the menu 
below the Send button. If “Personal” is selected, then the 
message will only be sent to the user that has been selected 
in the users, list in the left column of the Group window. 
The selected user does not have to be in the group that the 
current user is in. If “Group” is selected, then the mes- 
sage will be sent to all members of the current group. If 
“Announcement” is selected, then the message will be dis- 
played in a pop-up window in all group members’ clients. 
The “Send Beep” checkbox of the Group window indicates 
whether the user wants a beep to be sounded on all group 
members’ clients when their message is received. 



Fig. 4. Group Window 

VII. GROUP STATE AND INITIALIZATION 
The server maintains a state for each group. The state 

includes information on all current client users, all current 
markers, cumulative group messages, and current group 
views. When a user joins a group, their client is auto- 
matically initialized with the group state, i.e., all the group 
views are automatically opened, all the markers are dis- 
played, and the group messages are displayed. The group 
state is also useful for on-going group users. If a group 
user deletes one of more group views for some reason, then 
they can automatically reopen them by selecting “Refresh 
Group Views” in the View menu of the Group window, as 
discussed above. This is possible due to the server main- 
taining the group state. 

VIII. COLLABORATIVE SEQUENCE EDITING 
Collaborative sequence editing enables users to simul- 

taneously edit a common sequence. This reduces the se- 
quence generation time by having different parts of the se- 
quence developed in parallel. 

The basic hierarchy of a sequence is sequence, request, 
activity, command. Any number of requests can be in a 
sequence, any number of activities can be in a request, and 
any number of commands can be in an activity. Resource 
allocations and time constraints are specified at the request 
level. Resource allocations include time duration, energy, 
and data volume. Time constraints specify specific times 
when tasks must begin or end by. 

For collaborative sequence editing, ownership of the se- 
quence is specified at the sequence and request levels. The 
owner of a sequence can modify the structure of the se- 
quence including adding and deleting requests and speci- 
fying owners for each request. The sequence owner cannot 
modify the activities inside a request that is owned by a dif- 
ferent user (although the sequence owner can delete a com- 
plete request). The owner of a request can add, delete, and 
modify the activities inside the request, but cannot modify 
the constraints and resource allocations for the request. 

To collaboratively edit a sequence, a user first checks out 
the sequence. The sequence is copied from the common 



server to the user's WITS client. The user then modifies 
the sequence as appropriate for their ownership. Updating 
the common server sequence with the user changes is called 
merging. 

To merge a sequence owner's changes to the common 
sequence at the server, the sequence owner user selects a 
menu item to modify the sequence structure. The origi- 
nal server sequence is copied and given a version number. 
Then the structure changes are made to the sequence. All 
requests in the modified sequence are used in the new se- 
quence. For all requests that were in the original sequence, 
the activities are copied from the original sequence and 
placed in the new sequence. 

A request owner merges changes to the common server 
by selecting a menu item to merge their changes to the com- 
mon server. The original server sequence is copied and 
given a version number. Then the requests in the original 
sequence that the current user is owner of are updated with 
the activities in the modified sequence. 

IX. IMPLEMENTATION 

WITS implements a clientkerver architecture to support 
group communications and other mission planning and op- 
erations activities. The WITS server is implemented as a 
Java application running on a computer at JPL. The WITS 
client is downloaded from the JPL WITS website and run 
as a Java application. 

communications since WITS is developed in a pure Java 
environment and RMI provides a number of advantages. 
RMI can pass full objects as arguments and return values, 
not just predefined data types. This means that complex 
types, such as a standard Java hashtable object, can be 
passed as a single argument. RMI provides secure chan- 
nels between client and server by using the secure socket 
factory. RMI provides a means for clients running behind a 
firewall to communicate with remote servers via tunneling 
messages through HTTP POST calls. 

The WITS server implements a group server RMI ob- 
ject to provide group collaboration services to the clients. 
When the user of the WITS client logs in, the client ob- 
tains the reference of the group server object from the RMI 
registry running at the WITS server site. The client then 
invokes the userLogin method with the username and 
password arguments for login validation. At the same time, 
the WITS client passes its group client object to the server. 
This enables the server to send messages to the client using 
a technique commonly known as server-to-client callback. 

Group collaboration in WITS uses both synchronous and 
asynchronous remote method calls. Synchronous calls can 
provide immediate results to the clients. For example, in 
the userLogin call, the user can know if a wrong pass- 
word has been entered. However, synchronous calls can 
hang the client for an indefinite length of time if the server 

RMI (Remote Method Invocation) is used for clienthewer 

or network is overloaded. Thus, to improve both user ex- 
perience and system performance, we implement most re- 
mote method calls to be asynchronous so that the client and 
server are loosely coupled. With asynchronous communi- 
cation, the server can schedule its processing group collab- 
oration requests more efficiently because it does not have 
to reply to each call immediately. For the client, it can con- 
tinue to handle other tasks such as screen update and user 
input after it submits a group collaboration request. 

The group server maintains a queue of pending group 
collaboration requests submitted by the clients. The re- 
quests are processed in the first-come-first-serve basis. As 
multiple clients can concurrently submit asynchronous re- 
quests and make synchronous remote method calls, atten- 
tion must be paid to ensure that group state data, such as 
the list of users, will be updated atomically and without 
causing deadlock. The &a language provides the synchro- 
nized primitive that automatically guarantees that two or 
more threads will not be updating the object or executing 
the method that has been declared as synchronized. We 
make use of this feature to implement the serialization of 
updating the group state data. 

The states of group collaboration are always maintained 
at the Group Server. They include the lists of users and 
groups, group messages, markers, and views. When a user 
joins a group, the client will be updated with the current 
state of the newly joined group. This ensures the client 
to have the same group views, group markers, and discus- 
sions among group members. The group messages are also 
logged to a file for creating a record of the discussions. 

Another function of the group server is to detect termi- 
nated clients that have not properly logged out. It sends 
periodic probe messages to each client which will cause 
the remote method call to fail if the client no longer exists. 
When all the clients are logged out, the group server cleans 
up the states and closes the group message log file. 

WITS utilizes MIS (application programming inter- 
faces) provided by the Java 2 platform. The Swing graph- 
ical user interface components, such as tabbed pane, split 
pane, tree view, etc., are used to implement the user control 
and viewing functions. Java 2D is used to manipulate im- 
ages and draw 2D objects, while Java 3D is used to render 
solid models and Mars terrain. 

~~~ 

X. FUTURE PLANS 

The goal of fkture work is to make distributed collab- 
oration even more convenient. The planned environment 
requires support for two fundamentally different kinds of 
communication. First, remote users must have access to 
data products. Second, groups of users must be able to col- 
laborate. In the first case, availability is a large concem. 
The communication system should be resilient to lost mes- 
sages and periods of disconnection. The user should be 
able to cache copies of data products locally and continue 



to work in disconnected mode. To provide availability and 
disconnected operation, an appropriate technology is a gos- 
sip protocol [8], [9], [lo]. 

The second case is concerned with synchronous collab- 
oration where users are present at the same time, but per- 
haps not at the same location. A primary concern for syn- 
chronous collaboration is the creation of shared context, 
e.g., if all collaborators are viewing the same data prod- 
uct they can refer to features in that data product more eas- 
ily. Disconnected operation is not a concern for this type 
of communication because disconnection completely elim- 
inates the possibility of synchronous collaboration. To pro- 
vide shared context in a connected environment an appro- 
priate technology is a group multicast protocol [ lo], [ 1 11, 
[ 121. In the future we plan to support both modes of com- 
munication, and explore interactions that occur when col- 
laborators have both methods available. 

A gossip protocol functions in the following manner. 
The nominal state of this system is a disconnected state. 
Occasionally, two sites connect and exchange information 
about which messages each has received. Then each site 
forwards any messages not yet received by the other. A 
downlinked data product would be placed in the gossip log 
and eventually reach all sites. If the data product itself is 
too big a message announcing its availability can be sent. 
The system doesn’t have to worry about detecting and re- 
pairing broken communication links or resending messages 
because disconnection and resending are part of the nomi- 
nal operation of gossip. 

A group multicast protocol provides efficient delivery 
of messages to a set of destinations. An application can 
choose whether messages are delivered in a reliable or un- 
reliable manner. In addition, ordering conditions can be 
enforced on messages such as total order, causal order, or 
FIFO order. A group collaborator may take an action such 
as opening a new data product or making annotations, and 
that action should be visible to all other group members. 
To achieve this, the action is described in a message that 
is delivered by a group multicast protocol enforcing reli- 
ability and total ordering. This way, every member of the 
group sees the same set of actions in the same order so their 
shared context remains consistent. 

XI. CONCLUSIONS 
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Daily participation in Mars rover mission operations by 
geographically distributed scientist users via the Intemet 
will greatly benefit Mars missions both in cost savings 
and increased participation by scientific experts. The new 
group collaboration features described in this paper enable 
geographically distributed users to collaborate effectively 
in planning daily rover mission activities. 




